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CHAPTER 1: 

 

Docking analysis of Quercetin, Gallic acid and Hexanoic acid  with seven domains of 

Polyketide Synthase, A computational approach to contemplate  Quercetin, Gallic acid - 

mediated aflatoxin biosynthesis inhibition in Aspergillus flavus, A potent carcinogenic fungus 

1.1  ABSTRACT 

Aspergillus Flavus is the major opportunistic contaminant known to produce aflatoxin in food crops 

. Food contamination due to aflatoxins is a  safety concern for agricultural yields[1]. In order to 

identify and develop novel anti-aflatoxigenic agents, Explorative Studies on Phytochemicals as 

anti-aflatoxigenic agents have accrued remarkable importance including Quercetin and  Gallic acid 

which plays a  significant role in  providing defense  mechanisms against it. The  previously 

conducted experimental studies on Gallic acid  and  Quercetin suggested potential  Inhibitor [2] 

.Thus, to understand the molecular mechanism behind inhibition of aflatoxin biosynthesis by 

Quercetin and Gallic acid , an  interactive study with Polyketide Synthase A (PksA) of Aspergillus 

flavus was à fond conducted [3]. The 3D structure of  PksA  comprising of seven structural domains  

were  modeled using SWISS-MODEL server and systematic Docking  studies were performed  

using Auto dock tools-1.5.6 .Docking energies of the ligands Gallic acid , Quercetin and Hexanoic 

acid (as precursor) were compared with each of the domains of PksA enzyme. Binding energy for 

Quercetin and Gallic acid was lesser that ranged from (-6.96 to -5.86kcal/mol) and (-6.09 to -4.79 

kcal/mol) in comparison to Hexanoic acid (-5.05 to -3.36 kcal/mol). LigPlot analysis showed the 

formation of bonds in case of quercetin, 7 H bonds in Gallic acid and 3 H bonds in Hexanoic acid 

.During an interaction with acyl transferase domain, both Gallic acid and Hexanoic acid showed H 

bond formation at Glu36, Arg8,Thr11 positions. Also, in PP domain, Gallic acid creates six H 

bonds in comparison to one in Hexanoic acid .In ACP, TH, KS, PT Domains , No. of H bonds were 



observed more as compared to Gallic acid and Hexanoic acid. In AT, PP, CT domains, Gallic acid 

was observed to have more H bonds than Quercetin and Hexanoic acid.The dynamics of protein-

ligand complex formation for every domain was investigated through MD simulations. 

Phytochemicals showed stable binding with active site of polyketide synthase A (PksA) indicated 

by steady RMSD of protein backbone atoms and potential energy profiles. Overall results revealed 

that Quercetin  Followed by Gallic acid exhibited the highest level of binding potential (more 

number of H bonds) with PksA domain in comparison to Hexanoic acid; thus,  Quercetin and Gallic 

acid feasibly inhibits by virtue of  competitively binding to the  seven domains of polyketide 

synthase, a fundamental enzyme of aflatoxin biosynthetic pathway. Further, we suggest  that key 

enzymes from aflatoxin biosynthetic pathway in aflatoxin-generating Aspergilli could be traversed 

further using other phytochemicals as potential  inhibitors. 

1.2  INTRODUCTION 

The project entitled  "Docking analysis of Quercetin  , Gallic acid and Hexanoic acid  with 

seven domains of Polyketide Synthase , A provided insight into Quercetin , Gallic acid - 

mediated aflatoxin biosynthesis inhibition in Aspergillus flavus" is mainly concerned with 

objective of  " STUDY ON PHYTOCHEMICALS AS ANTI-AFLATOXIGENIC AGENTS , 

COMPUTATIONAL APPROACH TO STUDY THE MOLECULAR MECHANISM BEHIND 

INHIBITION OF AFLATOXIN BIOSYNTHESIS BY GALLIC ACID, QUERCETIN AND 

HEXANOIC ACID AND  STUDY THEIR INTERACTIONS WITH  POLYKETIDE SYNTHASE 

PKSA OF ASPERGILLUS FLAVUS". 

Aspergillus is indeed a morphological genus composed of around 250 recognizable species. The 

aspergillum is distinguished by its distinct and unique spore-bearing structure. Aspergillus flavus 

originally belonged to Flavi's section. This section includes the most critically Significant aflatoxin 



developing fungus like A. flavus. and A. parasiticus. In this segment, the less prevalent aflatoxin 

producing fungus include A. nomius, A. parviscleroti genus, A. bombysis as well as A. 

pseudotamarii [4]. 

Aspergillus flavus is an avaricious pathogen for agricultural products. It is essential because in  both 

pre and post harvest stages ,It causes aflatoxin to form as a secondary metabolite in a variety of 

crops [5].Aflatoxins are  polyketide derived secondary metabolites  ,highly regulated ,poisonous 

and  active  hepato-carcinogenic agents which are hazardous to animals as well as  in humans, it  is 

conventionally an exploitative pathogen for immuno-compromised individuals[6]. 

 

The development of aflatoxin is the combined effect of fungal life forms, substrates and the 

surrounding environment. The factors influencing the development of aflatoxin can be categorized 

into three parts: nutritional , biological and physical variables. Physical parameters like  pH, 

relative humidity as well as moisture, light, aeration,  can have an impact on aflatoxin production 

[7]. The genes involved in aflatoxin biosynthetic pathway are clustered, such as those of other 

secondary metabolites. Acetate' polyketides' are the primary precursors of the secondary 

metabolites. The diverse aflatoxins are developed through acetate as well as malonate building 

blocks formed mostly during idiophase. The four major key aflatoxins are CI7 compounds (AFB' 

AFB2, AFGI, and AFG2) defined as Nonaketides .Biosynthesis of aflatoxin has indeed been 

speculated to include at minimum 23 enzymatic processes. Aflatoxins are developed via Polyketide 

3anthraquinones3xanthones3aflatoxins acetate 3 conversion pathways. At least 15 

apparent structurally aflatoxin moieties in the aflatoxin biosynthetic pathway have thus far been 

established. It's been asserted that 25 genes are involved in aflatoxin biosynthesis and are clustered 

in a 70-kb segment of dna around the chromosome [8]. 



 

The polyketide biosynthetic pathway causes Aflatoxin biosynthesis in A. flavus to be a synchronous 

process. Polyketide synthase (PKS) is among the essential enzymes in the polyketide biosynthetic 

pathway [9]. Fungi corresponding to Type I polyketide Synthase comprises extremely significant 

multifunctional protein which is 180–250 kDa structured with Diverse multiple domains. Ketoacyl 

Synthase ,  acyl carrier proteins and acyl transferase  are the three major domain groups . There 

have been up to 30 genes and a substantial regulatory gene named aflR gene is involved into 

aflatoxin biosynthesis  involving  fatty acid synthases [10]. Research on Aspergillus nidulans 

indicated that the generation of secondary metabolite has since been completely rebuilt in mutants 

whenever mutant of fatty acid synthase itself was processed with hexanoic acid as a precursor [11]. 

 

Polyketides are believed to be the prime recipients for the development of anti-contamination 

therapeutics in agricultural yields caused by aflatoxin. Polyketides have been identified to be 

efficacious in decreasing aflatoxin contamination, but there are certain limitations existing along 

with it [12].An alternative approach to fungal contamination is the interface of Phytochemicals 

synthesized from diverse plant sources[13]. Plants develop  these secondary metabolites to provide 

a defense mechanism against pathogenic fungus[14].Due to the antimicrobial properties ,they have 

the capacity to  protect humans and animals against certain diseases induced by microorganisms 

and even toxins linked with them[15]. For potential drug research and growth, these metabolites  

have become the most effective chemo-preventative compounds[16]. 

 

Specific biological polyphenols including Gallic acid and Quercetin exhibits optimum inhibition  

against AFB1 production in Aspergillus flavus[17]. In almost every part of the plant, such as bark, 



wood, leaf, fruit, root as well as seed, Gallic acid and its derivatives are found in natural 

environment. Since using natural plant products and bio-control additives instead of synthetic 

chemicals allows scientists to avoid using toxic preservatives, this substitute to synthetic drugs is 

becoming a primary concern for scientists all over the world.Thus, to understand the Quercetin , 

Gallic acid and PksA interaction, Computational methodology could be a valuable  tool for 

researching aflatoxin inhibition mechanisms. The protein sequence of PksA from A. flavus was 

extracted from UniProt database to execute homology modeling. Phytochemicals  has been docked 

with the various PksA domains of A. Flavus, and as compared to the substrate, Hexanoic acid, it 

binds more efficiently. The position of H bonding and hydrophobic interaction of Quercetin ,Gallic 

acid  and Hexanoic acid with seven distinct domains of PksA was compared using Ligplot analysis. 

The dynamics of protein-ligand complex formation for every domain was investigate through MD 

simulations.  In contrast to Hexanoic acid, our results indicated that Quercetin and  Gallic acid had 

the highest degree of binding potential with PksA; therefore, Quercetin then Gallic acid could 

inhibit by conservatively binding to the seven domains of Polyketide Synthase, a key enzyme in the 

aflatoxin biosynthetic pathway. 

 

Aflatoxins are responsible for approximately to 25% of the entire world food crops being harmed, 

leading to economic losses in developed nations as well as human and animal illness in developing 

ones[18].Pathogenic and opportunistic fungal infections found in Aspergillus flavus species have 

the potential to induce mycosis (invasive aspergillosis) in humans. The emergence of drug-resistant 

isolates has limited the effectiveness of current antifungal medicines[19]. Various adapted cultural 

methods are now being used and researched to combat the problem of food contamination[17].Our 

study aim to evaluate the effect of phytochemicals like gallic acid as an alternative approach to 



fungal contamination and it may find its application in Phytochemicals based anti-  aflatoxigenic 

agents. 

 

1.3  LITERATURE REVIEW  

 

1.3.1  INTRODUCTION  

By producing aflatoxin (AFB1 and AFB2), Aspergillus flavus is one of the most potent pollutants 

of raw food commodities during pre- and post-harvest crops. The International Agency for 

Research on Cancer classifies these toxins as Category I toxins because they cause cancer. To 

prevent the toxin's severe effects on humans and animals, different safety administrations control 

the toxin's exposure level. A. flavus is also one of the most common causes of aspergillosis in 

immunocompromised patients. Aflatoxin biosynthesis in A. flavus is a multi-step process involving 

the polyketide biosynthetic pathway. Is one of the most important enzymes in the polyketide 

biosynthesis pathway? 

1.3.2 ASPERGILLUS FLAVUS, A POTENT CARCINOGENIC FUNGUS 

Aspergillus is a morphological genus that has over 250 species .The aspergillum is distinguished by 

its peculiar and exclusive spore-bearing structure. Aspergillus flavus was previously mentioned in 

Flavi's part. The highest deadly aflatoxin-producing fungus, such as A. flavus and A. parasiticus [4], 

are included in this category. Aspergillus flavus is a hazardous fungus that destroys agricultural 

crops It's significant since it generates aflatoxin to develop as a secondary metabolite in a number 

of crop types before and after harvest. It's an uncontrolled agricultural pathogen. It's critical to 

establish aflatoxin as a secondary metabolite in a range of crops either before and after harvest. 

Aflatoxin is a harmful carcinogen that is strictly controlled throughout most nations. Aflatoxin has 



been related to drought-stressed oilseed crops in the zone, including maize, peanuts, cottonseed, and 

tree nuts [20]. Under the right circumstances the fungus may grow and generate aflatoxin in nearly 

any preserved crop seed. Aflatoxin can be stored safely if the moisture level is kept below the 

minimum necessary for A. flavus development. Improving cultural methods, creating resilient crops 

using molecular and proteomic approaches, selective elimination by non-producing strains, and 

creating field treatments that prevent aflatoxin production are all being utilized or explored.  

1.3.2.1  HOST RANGE OF ASPERGILLUS FLAVUS 

Aspergillus flavus has a wide habitat spectrum as an uncontrolled pathogen/saprobe. This kind of 

soil fungus is quite prevalent. The main problem with this fungus in agriculture is that it develops 

extremely carcinogenic chemicals known as aflatoxins, which are detrimental to the welfare of 

animals. In the region, A. flavus is mostly a problem in the oilseed crops maize, peanuts, 

cottonseed, and tree nuts. Under the incorrect storage circumstances, A. flavus may develop and 

generate aflatoxin in nearly every crop seed. Animals and insects are both affected by this disease. 

In immunocompromised individuals, it is predominantly an uncontrolled pathogen. 

 

1.3.2.2  BIOLOGY AND HABITAT OF A. FLAVUS 

 

Aspergillus flavus species can pollute a variety of agricultural resources in field preservation sites 

comprising processing plants, and throughout transit. So far, af1atoxins have exclusively been 

discovered in A. flavus, A. parasiticus, and A. nomius [21].Toxicity of A. flavus strains ranges from 

harmless to generating aflatoxins B1 and B2, whilst aflatoxins BI', B2, GI, and G2 are produced by 

A. flavus, A. parasiticus. Aflatoxin-producing fungus are all soil microorganisms, although their 

dispersion patterns differ [22].In moderate climates A. flavus spores can be discovered in the air 



rather than in the soil. A. flavus, A. parasiticus thrives in hotter temperatures like the tropics and 

subtropics, and has been linked to soil [[23]. 

 

 

1.3.3 AFLATOXINS 

After more than 100,000 turkey poults in England died of apparent poisoning from mold-

contaminated peanut meal in the early 1960s, aflatoxins were discovered and characterized [24]. 

There are two types of aflatoxicosis, a disease caused by aflatoxin toxicity. Acute aflatoxicosis can 

be fatal. Cancer, with the liver as the primary target organ, immune suppression, teratogenicity, and 

other symptoms are all symptoms of chronic aflatoxicosis. Aflatoxins are difuranocoumarin 

derivatives that are formed via a polyketide pathway. The characters relate to the color of their 

fluorescence underneath ultraviolet light (blue or green), and the numbers indicate their relative 

migration distance on a thin-layer chromatographic plate. Only four significant aflatoxins, B1, B2, 

G1, and G2 (AFB1, AFG1, AFB2, and AFG2), contaminate crops and potentially cause risk to 

livestock and human health, out of at least 16 structurally related aflatoxins identified. The most 

hepatocarcinogenic naturally produced aflatoxin is Aflatoxin B1 which is a  cancer-causing 

substance [25].A. flavus produces aflatoxins, which are the most toxic and active hepatocarcinogens 

ever discovered in nature. Due to contrasting morphological and biochemical attributes, reliable 

species identification within the Aspergillus flavus complex remains difficult, and more taxonomic 

and population genetics work is needed to better understand the species and related species. The 

most toxic and carcinogenic compounds are aflatoxins, a category of polyketide-derived 

furanocoumarins. AFB1 and AFB2 are produced by Aspergillus flavus. 

 



 

1.3.4 Polyketide synthase (Pks)  

 

PKS is a monomeric protein that utilizes acyl units to generate complex natural products. Type I 

polyketide synthase is a very broad versatile protein (180–250 kDa) with several domains found 

in fungi. The key domain types are ketoacyl synthase (KS), acyl transferase (AT), and acyl 

carrier proteins (ACP).  

1.3.5  DOMAINS OF PROTEIN  
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FIGURE 2 : SEVEN DOMAINS OF POLYKETIDE SYNTHASE A 

 

1.3.6  STRUCTURE OF PROTEIN  

Parameters used for protein structural assessment by PROCHECK analysis are described in the 

following table. 

DOMAINS RAMACHANDRAN 

PLOT(%) 

G 

FACTOR 

MCBL(%) RESIDUES OVERALL 

QUALITY 

FACTOR 

ACP transacylase 

domain 

91.9
a
; 6.6

b
; 0.0

c
; 1.4

d
 -0.08

e
 ; 

0.15
f
; 

0.03
g
 

91.9 238 93.33 

β-Ketoacyl synthase 

domain 

88.3
a
;10.3

b
;1.1

c
;0.3

d
 -0.25

e
 ; 

0.16
f
 ; -

0.07
g
 

88.3 429 89.31 

Ketoacyl synthetase 

C-terminal 

domain 

85.3
a
; 13.2

b
;1.5

c
;0.0

d
 -0.27

e
 ; 

0.13
f 

; -

0.10
g
 

85.3 79 63.04 

Acyl transferase 

domain 

94.3
a
 ;5.3

b
 ;0.0

c
 ; 0.4

d 
 -0.15

e
 ; 

0.14
f
 ; -

0.02
g
 

94.3 299 97.53 

Product template 

domain 

89.3
a
 ;10.0

b
 ;0.7

c
 ;0.0

d
 -0.31

e
 

;0.21
f
 ; -

0.09
g
 

89.3 327 88.21 



Phosphopantetheine 

attachment 

site 

86.7
a
 ;13.3

b 
;0.0

c 
;0.0

d 
 -0.40

e 
;  -

0.01
f
 ; -

0.24
g
 

86.7 68 95.91 

Thioesterase domain 90.4
a
 ;9.1

b
 ;0.5

c
 ;0.0

d
 -0.25

e
 ; 

0.19
f 

; -

0.06
g
 

90.4 239 95.51 

 

MCBL distribution of main chain bond length , Overall quality factor by ERRAT 

a Residue in favored regions 

b Residue in allowed regions 

c Residue in generously allowed regions 

d Residue in disallowed regions 

e G factor score of dihedral bond 

f G factor score of covalent bond 

g Overall G factor score 

1.3.7 PHYTOCHEMICALS AS INHIBITORS  

Plants generate phytochemicals to assist them to withstand diseases from fungus, bacteria, and plant 

viruses, as well as for ingestion by insects and certain other animals. The term phyton means 'plant' 

in Greek. These have biological action in the plant habitat and aid in plant development as well as 

defense versus diseases and competition.  

Secondary metabolites are generated by plants as a protection against pathogenic microorganisms, 

insects, and harsh environmental conditions. These non-nutritive metabolites are referred to as 

phytochemicals [26]. However, because of their antimicrobial properties, they can safeguard 

humans and animals from diseases induced by micro-organisms or toxins correlated with them[13]. 



For potential drug research and growth, metabolites are the most effective chemo-preventative 

agents[27]. There are several large classes of phytochemical compounds that have been discovered 

to date, each with its chemical structure[28]. 

 

Phenolic compounds, phytosterols, carotenoids, tools, terpenoids, alkaloids, flavonoids, saponins, 

tannins, aromatic acids, glucosinolates, carotenoids, essential oils, chlorophyll, and organic acids, 

along with proteases inhibitors, are the primary categories of phytochemicals [29]. Such chemicals 

can operate directly or indirectly to prevent illnesses or fungal infections because some include 

antimutagenic, antigenotoxic, antimicrobial, anthelmintic, anticarcinogenic, antiproliferative, anti-

inflammatory, and antioxidant capabilities[30]. 

 

Biologically produced polyphenols including Gallic acid, catechin, epigallocatechin, and Quercetin, 

of which Quercetin and Gallic acid inhibited AFB1 synthesis in A. flavus the most. The use of 

phytochemicals derived from a variety of plant sources might be a viable option for treating fungal 

infestation [31]. 

 

1.3.7.1 GALLIC ACID 

Gallic acid is a phenolic acid found in a diverse range of relatively high plant species both within its 

pure form and as a component of greater complex compounds like ester derivatives or polymers. 

Gallic acid and its metabolites may be found in almost every component of a plant, including the 

bark, wood, leaf, fruit, root, and seed. They might very well be discovered in a range of foods, 

notably blueberries, blackberries, strawberries, plums, grapes, mango, cashew nut, hazelnut, walnut, 

tea, and wine. Gallic acid (GA), a component of the Tulare walnut pellicle, has shown to be a 



potent inhibitor of aflatoxin biosynthesis [32], GA was proven to greatly inhibit the expression of 

the farB gene, which regulates peroxisomal fatty acid oxidation[33], as well as the carbon 

repression regulator encoding gene, creA, which was recently discovered to be engaged in aflatoxin 

production[34]. Simultaneously, 0.8 percent (w/v) GA treatment significantly reduced the 

expression of about all allocated genes in the aflatoxin biosynthesis cluster. This sheds light on the 

biological processes underlying oxidative stress responses in A. flavus that contribute to aflatoxin 

biosynthesis. 

1.3.7.2  QUERCETIN 

Quercetin is a plant polyphenol that belongs to flavonoids, commonly found in fruit, vegetables, 

seeds, tea, wine, flower, nuts, propolis, and honey. To remove aflatoxin from the food chain, a 

long-term and cost-effective source is needed. Natural Phytochemicals derived from various parts 

of plants, including fruits, vegetables, and spices, have been shown to have a broad variety of 

biological effects, including antioxidant, antimicrobial, and anti-inflammatory properties. As a 

result, to control contamination and increase yield, alternative approaches that are both 

economically feasible and environmentally sustainable are needed [35]. The inhibition of AFB1 

development in A. flavus by Quercetin produced promising results[36], including aflatoxin 

inhibition at 800 g/mL. In aflatoxin-mediated hepatic harm cells (HepG2) in mice, Quercetin 

inhibited the formation of reactive oxygen species, cytotoxicity, and lipid per oxidation[37]. To 

learn more about quercetin's function in inhibiting aflatoxin biosynthesis in A. flavus, researchers 

conducted a study where they used nano-liquid chromatography-quadruple time-of-flight mass 

spectrometry to analyze the proteome of Aspergillus flavus cultured in corn flour media (CF) and 

corn flour media with Quercetin (nLC-Q-TOF). It showed that in contrast to CF, trans-membrane 

transporter proteins were highly expressed in response to CFQ. In addition, in contrast to CF, the 



cAMP/PKA signaling pathway was observed in CFQ. AFB1 was also measured using quantitative 

high-performance liquid chromatography (HPLC) at various time points (7, 12, 24, and 48 hours). 

Overall, it showed that the presence of Quercetin inhibited aflatoxin biosynthesis in A. flavus [1]. 

1.3.8 ABOUT INHIBITION OF AFLATOXIN BIOSYNTHESIS 

The natural occurrence, diagnosis, classification, biosynthesis, and genetic regulation of aflatoxins, and also 

the prevention and management of aflatoxin contamination of food and feed, have all been studied in great 

depth. At least 23 enzymatic reactions are thought to be involved in the biosynthesis of aflatoxin. In the 

aflatoxin biosynthetic pathway, at least 15 structurally aflatoxin intermediates were identified so far. It has 

been shown that 25 genes clustered within a 70-kb DNA region on the chromosome play a role in aflatoxin 

biosynthesis. Aflatoxin biosynthesis genes, including those for certain secondary metabolites, are grouped 

[38]. The cluster has been sequenced and annotated in its entirety[39]. Understanding the biosynthesis of 

aflatoxin is hoped to aid in the creation of control methods as well as provide insight into how and why 

aflatoxin developed. In A. flavus, there are around 30 genes in aflatoxin 

synthesis, including fatty acid synthases, as well as a major regulatory gene (AflR). When mutations of fatty 

acid Synthase were encountered with Hexanoic acid, the synthesis of secondary metabolites was 

preserved in mutants, according to a study on Aspergillus nidulans. It was suggested that polyketides are the 

frontline for the development of therapeutics against aflatoxin contamination in various agricultural 

crops[40]. The application of the biological agent to out-compete toxic effects of aflatoxins in pre- and post-

harvested food crops has proven to be effective in reducing aflatoxin contamination; however, certain 

limitations exist. 

 

1.3.9 COMPUTATIONAL APPROACH TO CONTEMPLATE STUDY 

Understanding the mechanism of aflatoxin inhibition could be aided by a computational approach. 

As a result, developing a novel target necessitates an understanding of the host's mRNA and protein 

expression systems in response to stress. To best explain the interaction between Quercetin, Gallic 



acid, and PksA, the protein sequence of PksA from A. flavus was evaluated. Furthermore, utilizing 

Quercetin and Gallic acid as ligands and Hexanoic acid as a precursor, domains and molecular 

docking studies were carried out. The total findings of molecular docking and LigPlot analysis, 

which included binding energy, electrostatic energy, H bonding, bond length, and hydrophobic 

interaction, suggested that Quercetin, Gallic acid, had the most binding potential with PksA 

domains in comparison to Hexanoic acid. 

 

1.3.10 SOFTWARES USED  

 

 

 

 

1.4  MATERIALS AND METHODS 

 

1.4.1 ANALYSIS  OF BIOLOGICAL DATA AND  SEQUENCE RETRIEVAL  

The complete amino acid sequence of  A. flavus polyketide Synthase was acquired from the protein 

database of NCBI ( National Centre For Biological Information), with the NCBI gene ID of 

7914331, gene symbol: AFLA_139410 , gene description: AflC / pksA / pksL1 / polyketide 

Synthase and Uniprot accession number B8NI04_ASPFN. FASTA SEQUENCE was retrieved 

from the NCBI database. 



 

 

FIGURE 3 : FASTA SEQUENCE OF POLYKETIDE SYNTHASE 

 

 

1.4.2 Protein Blast for finding Homologous sequences 

The regions of similarity between the native sequence and other sequences were found using 

BLAST, The FASTA sequence was used as a QUERY to search for homologous sequences using 

BLAST in NCBI. 

 



 

FIGURE 4 : PROTEIN BLAST 

The homologous sequences of more than 90% sequence identity were retrieved. 

 

FIGURE  5  :  HOMOLOGOUS SEQUENCES 

 

1.4.3 Homology modeling and Phylogenetic analysis 

 



A phylogenetic tree is a branching diagram that depicts the phylogenetic connection between 

diverse biological species based upon similarities and differences in their structure and function. 

Following the Maximum likelihood, the method provides probabilities of the sequences given a 

model of their evolution. The more probable the sequences are given in the tree, the more the tree is 

preferred. The homologous sequences with more than 90% identity were aligned using the MEGA 

6.06 tool and as a result, a phylogenetic tree was constructed, using the maximum likelihood 

method. 

 

 

 

FIGURE 6: PHYLOGENETIC TREE OF HOMOLOGOUS SEQUENCES 

 

 

1.4.4  LIGAND PREPARATION  

Ligands must be prepared to create 3-D geometrics, assign proper bond orders, charges, hydrogens, 

and minimize the structure. Ligand preparation is done before docking for energy minimization as it 



is used to reduce the overall potential energy of the ligand since biological systems are very 

dynamic and have low potential energies (-ve delta G) for Spontaneous interactions. Less is the 

energy, more spontaneous will be the interactions. 

SOFTWARE AND DATABASE USED: PubChem and UCSF CHIMERA. 

STEPS INVOLVED IN LIGAND PREPARATION : 

1.  Opened UCSF Chimera for VISUALIZATION and ANALYSIS of molecular structures, 

used for ligand preparation before docking. 

2.  Opened PubChem in the browser and type inhibitor ( ligand ) name i.e. GALLIC ACID and 

HEXANOIC ACID. 

3. Opened PubChem in the browser and type inhibition ( ligand ) name i.e. GALLIC ACID 

and    HEXANOIC ACID. 

4. In UCSF Chimera Tools, go to  Structure Editing followed by Build Structure. Paste the 

SMILES string that we have copied from PubChem and apply. 

5.  Now, the ligand molecule was built. 

6. Opened  Tools and did Structure Editing to Minimize Structure (here the steepest descent 

steps are set as 1000 and Conjugate gradient steps as 1000)  

7. The Add hydrogens window  poped-up, clicked OK, then Assigned Charges to minimize 

select Gasteiger and entered OK. This  showed the net charge of the molecule. Clicked 

OK.Saved ligand to the working directory: saved as .mol2 



 

FIGURE 7: GALLIC ACID LIGAND VISUALIZATION IN PYMOL 

 

1.4.5 Analysis of molecular properties of ligands 

In the UCSF chimera, a three-dimensional structure of both ligands including Gallic acid and 

Hexanoic acid was developed, which was visualized in Pymol, and  Table 1 shows the results of 

Lipinski's five-rule evaluation. The results revealed drug-like attributes for these two ligands, along 

with three - dimensional structure for molecular docking research. 

 

 

 



FIGURE 8: Three-dimensional structure of Gallic Acid (PubChem CID:370) and hexanoic acid (Id: 

8892) were obtained from Pubchem 

 

 

Compoun

d 

Molecular 

weight  

H-bond 

donor 

H-bond 

acceptor 

Log P Molecular 

Refractivit

y 

Pubchem 

Cid 

Molecular 

formula 

Hexanoic 

acid 

116.16g/m

ol 

1 2 1.92 125.3074 8892 C6H12O2 

Gallic 

acid  

170.12g/m

ol 

4 5 0.7 100.4250 370 C7H605 

 

TABLE 1: Lipinski's rule of 5 outlines the molecular properties of ligands 

 

1.4.6   PROTEIN STRUCTURE PREPARATION  

 

SOFTWARE AND DATABASE USED:   NCBI, SWISS MODEL, AND UCSF CHIMERA 

1. Seven different domains of PksA from A.flavus with their respective locations were retrieved 

from the GENE database of NCBI. 

2. Took the protein sequence from the UniProt knowledge database, extracted the desired located 

sequence from the whole protein sequence for each domain. 

3. The SWISS-MODEL service was used to design all seven domains of PksA, and the best feasible 

model was chosen based on the sequence discovered for homology modeling. To locate templates 



and align target templates, the SWISS-MODEL template library employs the BLAST and HHblits 

search engines. 

 

 

 

 

Figure 9 – Swiss model analysis 

 

 

4. These methods ensure strong alignment at all levels of sequence identity, resulting in an 

experimental approach, resolution (if applicable), quaternary state assignment, sequence identity to 

the target, coverage, as well as other factors that point to the best possible template for our 

structure. 

 

5. For further investigation, all protein structures are stored in PDB format. 



6. Opened UCSF Chimera for VISUALIZATION and ANALYSIS of molecular structures of seven 

domains, used for protein preparation before docking. 

7.Selected  Tools -> Structure Editing -> Minimize Structure (here set steepest descent steps: 100 

and Conjugate gradient steps:100) -> Minimize 

8.Added hydrogens, then Assigned Charges to minimize select Gasteiger and enter OK. This will 

show the net charge of the molecule. Click OK. 

9. Saved the protein to the working directory: save as .pdb.  

 

DOMAIN NAME  SMTL ID SEQUENCE IDENTITY  

ACP Trans acylase domain  6fij.1.A  32.49%  

  

Beta-Ketoacyl Synthase  6fij.1.A  58.78% 

Acyl Transferase Domain  6fik.1.B  39.60% 

PKS Product Template Domain  3hrr.1.A  99.69% 

Phosphopantetheine Attachment 

Site  

2kr5.1.A  98.53% 

Thioesterase Domain  3ils.1.A  99.58% 

Ketoacyl-synthetase C-terminal   

extension 

6fij.1.A  55.70% 

 



TABLE 2: TABLE OF SEVEN DOMAINS WITH THEIR RESPECTIVE SMTL ID AND 

SEQUENCE IDENTITY 

1.4.7 Structure stability of protein validated by the Ramachandran plot using Procheck 

server 

 

Protein structures saved in the PDB format from the Swiss model were validated by PROCHECK 

as shown in the following table 3. 

 

DOMAIN  DOMAIN STRUCTURE RAMACHANDRAN PLOT  

ACP 

TRANSACYLASE 

DOMAIN 

 

 



BETA-

KETOACYL 

SYNTHASE 

 

 

 

ACYL TRANSFERASE 

DOMAIN 

 

 



PKS PRODUCT 

TEMPLATE  

DOMAIN 

 

 

PHOSPHOPANTETHEIN

E   

ATTACHMENT SITE 

 

 



THIOESTERASE 

DOMAIN 

 

 

KETOACYL-

SYNTHETASE C 

TERMINAL 

EXTENSION 

 

 

 



TABLE 3:  STRUCTURE STABILITY VALIDATED BY THE RAMACHANDRAN  PLOT 

USING PROCHECK SOFTWARE 

 

 

1.4.8  MOLECULAR DOCKING STUDIES 

Molecular docking is an intriguing scaffold for comprehending drug biomolecular encounters for 

rational drug design and discovery including in mechanistic research by placing a molecule (ligand) 

in a non-covalent way into the selected binding site of the target-specific expanse of the 

DNA/protein (receptor) to produce a stabilized complex with probable effectiveness and better 

specificity. The binding energy, free energy, and stability of complexes can all be estimated using 

the docking technique's data. Currently, the docking methodology is used to estimate the ligand-

receptor complex's putative binding characteristics in advance. The basic goal of molecular docking 

is to create a ligand-receptor combination that has an optimal conformation and has a lower binding 

free energy. The net anticipated binding free energy (Gbind) is expressed in terms of different 

characteristics, including hydrogen bond (Ghbond), electrostatic (Gelec), torsional free energy 

(Gtor), dispersion and repulsion (Gvdw), desolvation (Gdesolv), and total binding free energy 

(Gbind), total internal energy (ΔGtotal) and unbound system’s energy (ΔGunb). As a result, a 

thorough grasp of the basic ethics that control anticipated binding free energy (Gbind) yields 

additional insights into the nature of diverse types of interactions that lead to molecular docking.  

Quercetin and Gallic acid were docked with seven distinct domains for A.flavus PksA and 

compared to the substrate, namely Hexanoic acid, which is known to be involved in PksA 

activation as well as the control of aflatoxin biosynthesis. 

1.4.8.1  DOCKING USING AUTODOCK 4.2 



Bioinformatics has finally advanced to the level that it can practically predict the molecular 

interactions that maintain a protein and ligand-bound in the bound state. The AutoDock software 

was developed to provide a mechanism for projecting the interaction of micro molecules with 

macromolecular targets that can readily differentiate amongst compounds with micromolar and 

nanomolar binding constants, as well as rank molecules with lower affinity differences. Testing a 

variety of compounds or compounds with specialized binding qualities, alterations to an already 

existing compound The current work is a full description of the protocol for making AutoDock 

more user-friendly. The initial step is to locate the Ligand and Target.pdb files that are necessary 

from major databases. The second step is to use AutoDock 4.2 to create PDBQT format files for 

Target and Ligand (Target.pdbqt, Lig-and.pdbqt) as well as Grid and Docking Parameter files 

(a.gpf and a.dpf). 

1.4.8.2  Grid Generation (open docking) in AutoDock  

1.File -> Read Molecule -> protein.pdb(prepared protein) 

2.Edit -> Delete Water 

3.Edit -> Hydrogens -> Add H -> Ok 

4.Edit -> Charges -> Add Kollman charges 

5.Edit -> Charges -> Compute Gastegier charges 

6.Atoms -> Assign AD4 type 

7.File -> Save -> Write PDBQT 

8.Ligand -> Input -> Open -> .mol2 files(prepared ligand) -> Ok 

9. Ligand -> Output -> Write PDBQT 

10. Grid -> Macromolecule -> Choose -> protein -> Save as .pdbqt 

11. Grid -> Grid Box -> adjust the grid covering all of the protein molecules, set the no. of X, Y, Z 



dimensions, and spacing accordingly. 

12. File -> Close saving current 

13. Grids -> Output -> gpf -> save as grid.gpf 

• Auto Grid 

1. Run -> Auto-Grid -> Program Pathname -> Browse -> C Drive -> (XProgram Files) -> The 

Scripps Research Institute -> Autodock -> 4.2.6 -> autogrid. 

2. For parameter filename -> Browse ->grid.gpf. 

3. Automatically a log filename file grid.glg will be created -> Launch 

• Auto Dock 

1. Docking -> Macromolecule -> RigidFilename -> protein.pdb 

2. Docking -> Ligand -> Choose -> .mol2 file -> Accept 

3. Docking -> Output -> Lamarkian -> Save as dock.dpf 

4. Run -> Auto-Dock -> Program Pathname -> Browse -> C Drive -> (XProgram Files) -> 

TheScripps Research Institute -> Autodock -> 4.2.6 -> autodock. 

5. For parameter filename -> Browse ->dock.dpf. 

6. Automatically a log filename file dock.dlg will be created -> Launch 

 

 

 

1.4.9  LIGPLOT ANALYSIS 

GALLIC ACID  HEXANOIC ACID  GALLIC ACID  HEXANOIC ACID 

ACP TRANSACYLASE DOMAIN PT DOMAIN 



 
 

 
 

ACYL TRANSFERASE DOMAIN PHOSPHOPANTETHEINE ATTACHMENT 

SITE 

 
 

 
 

KETOACYL SYNTHETASE C-TERMINAL DOMAIN Β-KETOACYL SYNTHASE DOMAIN 



 
  

 

THIOESTERASE DOMAIN   

 
 

  

 

Table 4 - Post-docking correlations among active residues of seven domains of Aspergillus flavus 

PksA with 2 distinct ligands i.e. Gallic acid and Hexanoic acid, as depicted in a schematic diagram 

created with LigPlot. 



 

1.4.10  MOLECULAR DYNAMIC SIMULATIONS 

MD (molecular dynamics) is a computer modeling technique for studying the physical movements 

of molecules and atoms. For a fixed period, the atoms and molecules are allowed to interact, 

providing a glimpse of the dynamic "evolution" of the system. Atomic and molecular trajectories 

are calculated in the most common version by Using interatomic potentials or force field molecular 

dynamics, mathematically analyzing Newton's equations of motion for a particle communicating 

device, whereby forces between both the particles and their potential energies also are gauged. 

Simulations are required to see how a molecule attaches to its receptor and how it affects the 

binding ability of molecules that bind elsewhere (in part by changing the configuration of the 

protein). Protein-Ligand Complex was prepared using  Pymol tool by editing Protein-ligand docked 

output files, creating the TOP-POSE protein-ligand complex. Parameterization of Protein-ligand 

Complex was done using Open-Babel and VMD software(http://www.ks.uiuc.edu/Research/vmd/) 

to start MD simulation by creating topology files for bound ligands. The Solvation Box was created 

and Force field  CHARMm was set as a simulation parameter. MD Simulations were run by 

creating a system and Minimizing it using NAMD 

software(https://www.ks.uiuc.edu/Research/namd/) where the results included Analysis of 

Trajectories, RMSD,RMSF , Hydrogen bonding, and Ramachandran plot which Mimics what 

atoms do with the potential energy function in real life and analyzes the physical movements of 

atoms and molecules as provided the positions of the other atoms, the energy equation can be used 

to measure the force encountered by any atom. Gallic acid simulation analysis is shown in table 5. 

 



 

FIGURE 10 : STEPS INVOLVED IN MD SIMULATION 

DOMAINS AVG STSD MIN MAX NUM 

ACP 1.88 0.68 0.09 3.99 102 

AT 2.15 0.58 0.09 0.89 102 

CT 1.35 0.24 0.04 1.58 102 

KS 0.80 0.13 0.05 0.94 102 

PP 0.97 0.19 0.04 1.17 102 

PT 1.73 0.45 0.05 3.21 102 

TH 0.83 0.15 0.03 0.98 102 

 

TABLE  5: TABLE OF SIMULATION OF GALLIC ACID 

note - avg, max, min, stdev and num >: When using the -all frames argument, this specifies the rule 

to use to merge frames. These correspond to retaining the average, maximum, and minimum values 

from the measured frames' set. The standard deviation for each point over the range of frames will 

be returned by stdev and num specifies the no. of atoms selected 



1.5.  RESULTS 

 

1.5.1 HOMOLOGY MODELING, SEQUENCE ALIGNMENT, AND PHYLOGENETIC 

ANALYSIS 

 

Protein BLAST identified regions of similarity between the biological sequences of proteins by 

Comparing them with databases of sequences and measuring their statistical importance. The 

results showed 24 protein sequence (PksA) homologs of more than 90 percentage identity, Based 

on Query coverage, E-Value and total similarity Ranking, the top 14 homologous sequences have 

been further analyzed to study the phylogenetic makeup of A. flavus PksA. The PksA array of A. 

Flavus is close to that of Aspergillus species, primarily A. oryzae, A. parasiticus, A. Pseudo 

Nomius, A. novoparasiticus, A. sergii, A. Arachidicola, and A. minisclerotigenes, according to the 

evolutionary tree shown in Fig. 6. In the UCSF chimera, a three-dimensional structure of both 

ligands including gallic acid and hexanoic acid was developed, which was visualized in Pymol. 

Table 1 shows the results of Lipinski's five-rule evaluation. 

The results revealed drug-like attributes for these two ligands, along with three - dimensional 

structure for molecular docking research. The NCBI conserved domain sequence database revealed 

that A. flavus has seven distinct PksA domains. The SWISS-MODEL server has been used to model 

only those seven PksA domains, and the absolute best model was selected depending upon the 

sequence specified for homology modeling (TABLE 3). The SWISS-MODEL Template Library 

uses the BLAST and HHblits scanning engines to find models and match them with target 

templates. These methodologies apply to experimental methods by ensuring operational alignments 

at all levels of sequence recognition, indicating the best template mechanism available for our 

structure. Table 2 shows the sequence of aligned and extracted templates with their respective 



template id. By analyzing residue-by-residue geometry and overall structure geometry, the stereo 

chemical consistency of a protein structure is tested using the Procheck server. The findings 

showed that 86.7–94.3 percent of all regions were in the most preferred area, 5.3–13.3 percent in 

the additionally permitted region, 0.0–1.5 percent in the generously allowed region, and 0–1.4 

percent in the disallowed region, according to the Ramachandran plot. The average goodness factor 

(G factor) was found to be between -0.02 and -0.24. The ERRAT tool measured the trends of non-

bonded interaction of various types of atoms and plotted the magnitude of the error function against 

the position of the sliding window of 9 residues, which was determined using statistics from highly 

refined structures. The result indicated the overall quality factors of seven domain structures which 

ranged between 63.04 - 97.53. As a result, homology models were used in molecular docking 

studies based on these validations. 

 

1.5.2  DOCKING CORRELATIONS  VALIDATED BY LIGPLOT ANALYSIS 

 

Quercetin, Gallic acid was showcased to interact with different A. Flavus domains and was linked 

to the substrate, Hexanoic acid, which is also active in PksA enhancement and aflatoxin 

biosynthesis control. Table 6 shows the prominence-derived dock scores for free binding energy, 

intermolecular energy, electrostatic energy, and inhibition constant values. In all domains, the 

binding energy of Gallic acid was observed to be significantly lower than with Hexanoic acid.  

Gallic acid had binding energy of 6.09 to 4.79 kcal/mol, while Hexanoic acid had binding energy of 

5.05 to 3.36 kcal/mol and the electrostatic energy of Gallic acid (0.81 to 0.26 kcal/mol) and 

Hexanoic acid (0.44 to 0.01 kcal/mol) are highly comparable. Intermolecular energy is directly 

proportionate to binding energy, which was between 7.58 and 6.29 kcal/mol for Hexanoic acid and 



between 6.54 and 4.85 kcal/mol for Hexanoic acid. A reduction in intermolecular energy was 

observed along with Final Internal Energy which is in the range of -1.68 and -1.03 in Gallic acid 

and -0.17 and -0.06 in Hexanoic acid, implying that Gallic acid is a more effective binder with 

these domains. However, Quercetin showed the highest binding energy i.e -6.82 kcal/mol to -4.76 

kcal/mol. 

 

The Hydrogen bonding and hydrophobic active sites of Gallic acid, as well as Hexanoic acid with 

seven main domains of PksA, were identified and compared using LigPlot tools. Out of seven 

domains, Both Gallic acid and Hexanoic acid showed the maximum inhibition with Thioesterase 

Domain and lowest inhibition potential with Phosphopantetheine attachment domain. Gallic acid 

formed 7 H bonds, while Hexanoic acid formed 3 H bonds, according to LigPlot research. When 

the acyl transferase domain interacts with it, both Gallic acid and Hexanoic acid showed H bond 

formation at Glu36, Arg8, Thr11 positions. Also, in the Phosphopantetheine attachment domain, 

Gallic acid creates six hydrogen bonds in contrast to the one in Hexanoic acid. In ACP, TH, KS, PT 

Domains, No. of H bonds were observed more as compared to Gallic acid and Hexanoic acid. In 

AT, PP, CT domains, Gallic acid was observed to have more H bonds than Hexanoic acid.  Since in 

correlation to Hexanoic acid, Gallic acid showed the maximum binding long-term potential 

(maximum proportion of Hydrogen bonding) well with PksA domain; therefore, Gallic acid can 

inhibit by collegiately binding well to polyketide Synthase domains. This comparative analysis is 

shown in table 7. 

 

  



 

PROTEIN 

DOMAINS 

LIGANDS BINDING 

ENERGY 

(kcal/mol) 

INHIBITION 

CONSTANT 

(uM-

micromolar) 

INTERMOL-

CULAR 

ENERGY 

(kcal/mol) 

 

ELECTRO

STATIC 

ENERGY 

(kcal/mol) 

TOTAL 

INTERNAL 

ENERGY 

(kcal/mol) 

ACP transacylase 

domain 

QUERCETIN 

 

-6.44 

 

 

19.16 

 

 

 -8.23 

 

 

-0.19 

 

 

 -2.30 

 

GALLIC ACID 

 

-5.25 546.00 -6.47 -0.27 -1.66 

HEXANOIC 

ACID 

-4.47 531.02 -5.96 -0.29 -0.18 

β-Ketoacyl 

synthase    domain 

QUERCETIN -6.82 

 

 

 

9.95 

 

 

 -8.61 

 

 

 -0.49 

 

 

 

-2.62 

 

 

 

GALLIC ACID 

 

-5.29 

 

 

131.53 

 

 

-6.79 

 

 

-0.15 

 

 

-1.23 

HEXANOIC 

ACID 

-4.55 463.24 -6.04 -0.40 +0.00 

Ketoacyl synthase 

C-terminal 

QUERCETIN 

 

-5.30 

 

129.48 

 

 -7.09 

 

-0.13 

 

-2.70 



domain    

 

 

GALLIC ACID 

 

-4.78 

 

 

311.02 

 

 

 

-6.28 

 

 

-0.32 

 

 

-1.35 

HEXANOIC 

ACID 

-3.81 1610 -5.30 -0.37 -0.09 

Acyl Transferase 

domain 

QUERCETIN 

 

-4.76 

 

 

324.97 

 

 

  -6.55 

 

 

-0.07 

 

 

-2.78 

 

GALLIC ACID 

 

-4.48 

 

 

520.00 

 

 

-5.97 

 

 

-0.10 

 

 

-1.66 

HEXANOIC 

ACID 

-3.85 

 

 

 

1500 -5.35 -0.19 -0.15 

PROTEIN LIGANDS BINDING 

ENERGY 

INHIBITIO

N 

CONSTANT 

INTERMOL 

ECULAR 

ENERGY 

ELECTR

OSTATI

C 

ENERGY 

INTERNA

L 

ENERGY 

Product template QUERCETIN -6.05 36.87 -7.84 -0.17 -2.72 



domain  

GALLIC ACID 

 

-4.86 272.33 -6.35 -0.23 -1.29 

HEXANOIC 

ACID 

-3.81 1610 -5.30 -0.37 -0.09 

Phosphopantet-

heine attachment 

site 

QUERCETIN 

 

-5.21 150.85 -7.00 -0.51 -2.72 

GALLIC ACID 

 

-4.83 287.97 -6.32 -0.75 -1.00 

HEXANOIC 

ACID 

-3.36 3360 -4.85 -0.49 -0.12 

Thiosterase 

domain 

QUERCETIN 

 

-5.90 47.03 -7.68 -0.15 -2.73 

GALLIC ACID 

 

-5.97 41.79 -7.47 -0.53 -0.88 

HEXANOIC 

ACID 

-4.83 1470 -5.36 -0.10 -0.15 

 

TABLE 6 : Comparative analysis of known protein domains and ligands (Gallic acid , Quercetin 

and Hexanoic acid) on target molecule domains on the basis of Binding energy , Intermolecular 

energy ,electrostatic energy, Inhibition constant and Total internal energy 

 

 



 

 

 

PROTEIN  

DOMAINS 

 

LIGAN

D 

 

N0. OF 

HYDROGEN 

BONDS 

 

HYDROGE

N 

BONDING 

 

BOND 

LENGTH() 

 

HYDROPHOBIC 

BONDING 

 

 

 

ACP 

GA 4 Leu70, 

Gln6 

 

2.95,2.90,2.81,2.75 Arg75,Tyr65, Pro232 

HA 3 Tyr65, 

Arg75, 

Gln6 

2.90,2.87,2.80 Gly68,Leu70,Pro232 

QU 5 Asp159 

Ser157 

Asp162 

Cys234 

2.90,2.73,2.05,3.06

, 

3.08 

Cys156,Gly161,Leu147,Arg1

50, 

Pro72,Arg160z 

 

 

 

CT 

GA 5 Glu36, 

Arg8, 

Thr11 

3.21,3.07,2.98,2.96

,2.73 

Glu32,Ala34,Pro12,Asp33, 

His10,Pro35 

HA 3 Glu36, 

Arg8, 

Thr11 

3.09,3.03,2.63 Pro12,Pro35,Ala34,Asp33, 

CHis10 



QU 3 Glu42, 

Leu83 

2.70,3.15 , 3.08 Thr41 , Ala81 , leu 80 , 

His49,  

Arg46 , Ser47 , Asp44 , 

Lys43 

 

 

 

 

 TH 

 

GA 

4 Asp174, 

His222, 

Arg195 

3.11,2.68,2.79,2.72 Lys194,Thr175,Asn221,Phe1

90,Met191,Asp98 

,Gln193 

HA 1 Phe190 3.32 Thr175,Gln193,Val76,Asp98,

Met191,Ala173,His222, 

Ala172,Asp174,Arg195,Lys1

94 

QU 5 Ala12 

Leu21 

Leu18 

Tyr15 

2.68,2.72,3.11,3.02

, 

2.63 

Phe13 , Ala16 , Val27 , Thr25 

, 

Ala26 , Arg20 , Phe19  

 

 

 

 

 

      PP 

 

GA 

6 Glu66, 

Arg63, 

Leu18, 

Asp20 

2.74,3.00, 2.55, 

2.89 

3.26, 2.70 

Met4,Val62,Thr19 

HA 1 Arg63 2.87 Val62,Asp20,Glu66 

QU 5 Phe68 

Ala2 

2.82,2.58,2.90,3.29

, 

Leu65 

Leu47 



Asp1 

Leu45 

2.97 Val3 

 

 

 

 

 

 

 

KS 

GA 3 Ser12, 

Trp60, 

Asp62 

3.15,2.79,2.64 Arg8, Leu61, Glu11, Phe63, 

Pro13, Phe9 

HA 2 Ile258 2.89,2.76 Lys242, Leu183, Ile241, 

Val257 , Trp184, Arg243 

Cys180, Ala1 

QU 4 Glu245 

Ala1 

Cys180 

 

2.97 , 2.93 ,2.94 , 

2.99 

Arg243 

Leu244 

Val257 

Ile258 

Ile241 

Leu183 

Trp184 

 

 

 

 

 

PT 

GA 3 Phe227, 

His230, 

Leu272 

3.10,3.05,2.70 His233, Ala228 , Thr226 

HA 0 - - Met187,Gly183,Leu200,Arg1

80, Leu203, Tyr178 , 

Phe243,Tyr184,Tyr202 



QU 6 His261, 

Asn260 

Cys45 

Tyr50 

2.95,2.36,2.96,3.12

, 

2.83,2.78 

Leu90, Val86, 

Asp87,Arg315,Ala89, Lys88 

Leu44 

 

 

 

 

AT 

GA 7 His246, 

His196,Ser93 

Leu94,Gln65, 

Arg118 

2.92,2.92,3.03,3.16

, 

2.92,2.57,3.12 

Leu122,Phe195,Cys247 

HA 3 Gln8,Leu94, 

Ser93 

2.59,3.05,3.15 Phe195,His246,His196,Arg11

8 

,Gly7 

QU 5 His150,His19

6,Arg248 , 

Val154 

2.53,2.89,2.79,2.68

, 

2.51 

Cys152, 

Glu153,Thr250,His249 

 

 

TABLE 7 : COMPARATIVE ANALYSIS ON THE BASIS OF HYDROPHOBIC AND 

HYDROGEN BONDING OF QUERCETIN,  GALLIC ACID AND HEXANOIC ACID WITH 

DIFFERENT PksA DOMAINS OF ASPERGILLUS FLAVUS 

 

1.5.3 SIMULATION 

 



To gain a better understanding of protein binding affinity and to obtain dynamic insights into 

complex systems, MD simulations had been conducted . MD simulations were conducted on the 

processed hits from molecular docking experiments of Gallic acid and Hexanoic acid as reference 

inhibitor by using VMD as a molecular visualization software that uses 3D graphics and integrated 

scripting to view, animate, and analyze large bio-molecular structures of protein and ligand and  

NAMD software has been a parallel molecular dynamics code that uses the CHARMM27 force 

field as a simulation parameter for elevated simulation of complex bio-molecular systems. 

Simulations of molecular dynamics are used to model the diverse behavior of molecular systems 

over time. This system makes it possible for researchers to better comprehend the versatility and 

complexities of protein-drug binding. To every chosen molecule, a specific simulation system was 

developed. Open-babel software was used to create simulation parameters for all ligands. 

Simulations were run in a solvation box with its periodic boundary conditions with systems 

neutralized by incorporating counter ions to it. To prevent steric clashes,  an energy minimization 

component to every system was performed employing 5000 steps of the steepest descent algorithm 

and a total force of Thousand kJ/mol. The PME grid size was set 100 x 100 x 100 grid points and 

the temperature was set as 310 and MD simulations were run for 5000 steps. The root means the 

square value of Backbone atoms of proteins and energy profiles that can be measured using 

simulations of both Gallic acid and Hexanoic acid showed that the simulated systems are fairly 

stable. The RMSD values in the case of Gallic acid were between 0.80 nm and 2.15 nm for pksa - 

Gallic acid complexes and 0.62 nm and 1.47 nm in pksa-hexanoic acid complexes. Shifting RMSD 

values within the first few nanoseconds of simulations demonstrate the initial alteration of ligands 

at the active site of pksa. RMSD measurements were performed for the chosen molecule via the 

selected frames with a reference point of both specified molecule and its respective frame. The 



calculation's results appeared in the results list, where these are plotted in 2D or 3D graphs as 

shown in Figure 12. The results list contains details about the RMSD calculations that have been 

completed. Yet more RMSD analyses are made by using the heatmap plot function, selection of an 

appropriate Heatmap plot configuration.  Each RMSD metric could very well resemble a singular 

data point throughout the heatmap shown in Figure 11. The results of this analysis revealed that 

each simulation model obtained relatively stable potential energy profiles that remained constant 

during the simulation cycle. These results suggest that all protein-ligand complex structures are 

stable and consistent, paving the way for further research into binding modes, important molecular 

interactions, and free energy calculations. As a result, the RMSD, hydrogen bonding and heat map 

representation depicted Gallic acid to form more Stable RMSD of protein backbone atoms as well 

as Significant upside energy profiles in comparison to Hexanoic acid. 

 

 

 

 

 

 



 

FIGURE 11: HEAT MAP OF GALLIC ACID VS. HEXANOIC ACID 

 

 

 

 

 

 

FIGURE 12: RMSD TRAJECTORIES OF GALLIC ACID VS. HEXANOIC ACID 

 

 

 

 



1.6 DISCUSSION 

 

Aspergillus flavus does indeed have an expansive host spectrum as an invasive pathogen which is 

an unusually prevalent soil fungus. In agriculture, the primary concern with such a fungus is that it 

induces pharmacologically active toxins called aflatoxin which is carcinogenic in nature and a 

health threat for animals.  In human beings, it is extensively a deceitful pathogen for 

immunocompromised individuals [5]. Fungal species like Aspergillus flavus, Aspergillus nomius, as 

well as Aspergillus parasiticus, afflict plant species throughout development, growing and 

preservation are responsible for producing these hazardous toxins. These toxins can endure food 

production and are recognized being an unpreventable food contaminant by the Food and Drug 

Administration [41]. Synthetically, aflatoxins are derivatives of difuranocoumarin formed via a 

polyketide pathway. The key four toxins among sixteen structurally analogous toxins are the G1-G2 

and B1- B2 aflatoxins [24].  These characters correspond towards both colors underneath ultraviolet 

light (green or blue) of its fluorescence and to the figures showing their distance measure of 

mobility on the chromatographic slender plate. The main naturally produced formidable potent is 

Aflatoxin B1 as a carcinogenic agent [25]. The multi-domain polyketide Synthase A (PksA) 

enzyme encompasses a hexanoyl starter unit including seven malonyl-CoA adhesive units, which 

initiates aflatoxin biosynthesis by synthesizing the protonated norsolorinic acid anthrone in the 

dynamic aflatoxin B1 pathway. Aflatoxins' biosynthesis genes, as well as those of many secondary 

metabolites, have been grouped [42]. The whole cluster has also undergone sequencing and 

transcription [37]. The cluster of genes is eighty-two kb long as well as incorporates twenty-five 

diversified genes. Comprehending aflatoxin biosynthesis is anticipated to boost the creation of 

control methods that provide an insight into why and how the aflatoxin has been formulated. The 



genome of A. Flavus was lately sequenced [43]. The data thereby establish significant tools for 

comprehension of both fungus and aflatoxin production. Prevention seems to be the ideal solution 

to limiting the toxicity of aflatoxins Susceptibility to agricultural crop production. Scientists are 

gradually considering phytochemicals in comparison to conventional compounds to establish 

approaches to combat fungal diseases globally from the past few years. The term "Phytochemicals"  

is assigned to naturally produced, non-nutritive bioactive organic compounds of plant sources that 

have resistant and disease preventive characteristics. Many phytochemicals have become 

detrimental to fungi but can be utilized to protect crops, livestock, homo sapiens, food, and feed 

from toxic fungi. And hence, it's indeed vital to examine a feasible, cost efficiency, and non-toxic 

mechanism for the preventative measures for fungal degradation thereby creating   An opportunity 

to dissuade artificial preservatives implemented by the utilization of natural plant materials and 

biological control factors. Experimental data demonstrates Gallic acid exemplifies anti-

aflatoxigenic and anti-aspergillus functions [2]. A contingent of Tulare walnut pellicle, Gallic acid 

(GA), clearly indicates a significant inhibition effect against aflatoxin biosynthesis [32]. In-vitro 

analysis on Gallic acid showed significant inhibition against aspergillus flavus PKS A. Domain 

[44]. As a result, a computationally integrated study with Aspergillus flavus Polyketide Synthase A 

(PksA) was carried out to understand the mechanisms involved in underlying Phytochemicals 

suppression of aflatoxin biosynthesis[1]. 

In our analysis, Gallic acid, as well as Hexanoic acid as a precursor, exhibited similar binding 

properties by forming a single Hydrogen bond at Phe190 Position and 4 h bond at Asp174, His222, 

Arg195 positions. It also indicates a greater binding affinity for Gallic acid comparable to Hexanoic 

acid as the gallic acid’s binding energy was found to be − 6.09 kcal/mol in correlation with 

Hexanoic acid − 5.05 kcal/mol binding energy in the Thioesterase Domain of PksA . Hydrophobic 



interactions indicated that seven amino acids were involved in Gallic acid and eleven amino acids 

were involved in Hexanoic acid. Photochemical showed stable binding with active site of 

Polyketide Synthase A (PksA) Demonstrated by persistent RMSD and reliable energy profiles of 

protein backbone atoms. 

In the interaction with Gallic acid, the amino acids Arg75 and Tyr65 were found in the hydrophobic 

region although precluded in the interplay of Hexanoic acid with the ACP trans acylase domain as 

Gly68, Leu70 are involved with one common residue Pro232 in Hydrophobic Bonding. This 

implies that the ACP transacylase domain of PksA has distinct binding sites for Gallic acid and 

Hexanoic acid. Gallic acid's binding specificity with the ACP trans acylase domain, on the other 

hand, was found to be greater than hexanoic acid’s in terms of binding energy (5.29 kcal/mol vs. 

4.10 kcal/mol)and formation of Four H Bonds in Gallic Acid and Three for Hexanoic acid.In 

contrast to Hexanoic acid, in-silico techniques revealed active binding of Gallic acid with product 

template domain. Thus, GA is more stable due to the formation of 3 H bonds at Phe227, His230, 

and Leu272 positions and no bond formation in Hexanoic acid. In addition, among 7 domains of 

PksA, both ligands had the lowest electrostatic energy (-0.26/-0.01) when they interacted with the 

PT domain.  Gallic acid showed the Highest Intermolecular energy as compared to Hexanoic Acid 

(-1.68 /-0.09) with product template domain. In Ketoacyl synthetase C-terminal domain-pksa 

complex, both GA and HA show hydrogen bonding at Glu36, arg8, thr11 positions but ct-pksa with 

gallic acid is more stable due to the formation of 5 hydrogen bonds in Gallic Acid as compared to 3 

h bonds in Hexanoic acid. Among 7 domains, Acyl transferase domain and Phosphopantetheine 

attachment site showed the highest no. of hydrogen bonding with Gallic Acid i.e.  7 /6 and  3/1  in 

Hexanoic Acid Respectively. According to our findings, Gallic acid has a stronger binding affinity 

in these two domains than Hexanoic acid, since GA needs less binding energy for AT (− 4.82 



kcal/mol) as well as PP (− 4.79 kcal/mol) whereas Hexanoic acid required − 3.86kcal/mol and − 

3.36 kcal/mol, respectively. 

Natural components of polyketide undergo various frameworks and biochemical processes and 

combine with fatty acid synthesis, a subsection of biosynthetic measures.  Thioesterase most 

frequently performs the penultimate metamorphosis catalyzed by polyketide synthases as well as 

fatty acid synthases. In silico studies of Gallic Acid's interaction with the thioesterase domain of A. 

flavus, PksA, revealed that Gallic Acid had greater binding energy than Hexanoic Acid(− 6.09 

kcal/mol vs − 5.05 kcal/mol) validated by stronger hydrophobic interactions and  4 h bond 

formation at Asp174, His222, Arg195  positions in GA  as compared to 1h bond at Phe190  position 

suggesting among 7 domains, As a result, TH plays a key role in inhibiting aflatoxin biosynthesis in 

A. flavus. Also β-Ketoacyl synthase, The PksA domain demonstrated more extensive binding for 

Gallic Acid than hexanoic acid in respect of binding ability, including H binding and hydrophobic 

interactions. The molecular docking and molecular dynamic simulation of both Gallic acid and 

hexanoic acid with every domain of PksA revealed Gallic acid as a promising target for polyketide 

synthase inhibition based on in-silico analysis utilizing three - dimensional structure of seven 

domain category of A. flavus and evaluating their properties which include Hydrogen bonding and 

hydrophobic interactions along with its binding affinity and electrostatic energy. Following is the 

comparative graphical analysis of three ligands i.e. Quercetin, Gallic acid, and Hexanoic acid where 

Quercetin then Gallic acid showed the highest inhibition than Hexanoic acid. 

 

 

COMPARATIVE BINDING ENERGY ANALYSIS 

 



PROTEIN 

DOMAIN NAME 

QUERCETIN 

(Kcal/MOL) 

GALLIC ACID 

(Kcal/MOL) 

HEXANOIC ACID 

(Kcal/Mol) 

ACP -6.96 -5.29 -4.10 

AT -5.86 -4.82 -3.86 

CT -6.20 -4.95 -3.66 

KS -6.94 -5.33 -4.87 

PP -5.90 -4.79 -3.36 

PT -6.20 -5.17 -4.54 

TH -6.79 -6.09 -5.05 

 

 

   

 

 

 

 



CHAPTER 2 : 

Docking Studies on Shikonin as potential Hsp70 and Hsp90 Phytochemical inhibitor of 

Aspergillus terreus 

 

2.1 INTRODUCTION 

The fungus Aspergillus terreus has emerged as a significant opportunistic pathogen. Cancer rates, 

viral infections, and organ transplantation have all increased, resulting in secondary fungal illnesses 

[44]. Mortality, high persistence, lack of early diagnosis, and inherent Amphotericin B (AmB) 

resistance are all symptoms of A. terreus. A. terreus has gotten more attention in recent years due to 

an increase in immunocompromised patients. It has a built-in resistance to the conventional 

medication AmB. In A. terreus-diagnosed invasive aspergillosis, antifungal therapy options are 

limited. It is also a big clinical problem these days due to a greater rate (51%) of IA-related 

mortality. AmB is a broad-spectrum antifungal medication that is widely utilized. AmBRS was 

found to be very common (98%) all over the world [45]. 

 

2.1.1 PHYTOCHEMICALS AS  ANTIFUNGAL THERAPEUTIC  

Since 2013, the Leading International Fungal Education (LIFE) platform has recorded the burden of 

severe fungal illnesses in over 5.7 billion individuals around the world. In addition, 1.5 million 

deaths are estimated each year. As a result, in the current situation, alternative therapeutic 

procedures are required that are safe, effective, and environmentally friendly. In this case, 

Phytochemicals are the best option for antifungal action because they are natural.  

There is a constant quest for new chemicals and their mechanisms of action to develop high-

efficacy antifungals [19]. Plants are the primary producers of promising natural compounds with 



therapeutic potential in the treatment of fungal infections. Identification of novel Phytochemicals, 

as well as the creation of medications with lower toxicity and greater efficacy, are urgently needed. 

Anthocyanin, thiols, phenolic, flavonoids, tocopherol, and carotenoids are plant compounds 

generated from various portions of plants. These have a variety of biological effects, including anti-

cancer, antioxidant, antibacterial, and anti-inflammatory characteristics. 

 

 

 

2.1.2  SHIKONIN 

Shikonin is indeed a naphthoquinone compound that has undergone extensive testing for its 

pharmacological characteristics including its antioxidant and anti-inflammatory properties as well 

as its anti-cancerous, antioxidant, and antimicrobial features. Till now, only a few research have 

been carried on phytochemicals' action mechanism, cytotoxicity, synergy, including their anti-

virulence potential. As a result, we have examined some possible Phytochemicals to expand their 

medicinal applications. We determined that the evaluated Phytochemicals had an inhibitory impact 

on A. terreus, with Shikonin having the highest efficiency of all. Shikonin suppresses Aspergillus 

terreus multiplication by causing an oxidative burst and inhibits the glyoxylate route, which is an 

energy-recovery process[46]. 

2.1.3 ABOUT PROTEIN 

Shikonin was identified to control the Hsp70 and Hsp90 proteins of Aspergillus terreus in vitro. 

Shikonin stress is exemplified by these heat shock proteins. Previous research has shown that 

Hsp70 and Hsp90 blockers can overcome AmBRS in A. terreus and are thought to play a role in 

antifungal stress response in Aspergilli. 



Hsp70 protein, which is extremely conserved, has played a key function in the fungal system under 

diverse stress circumstances. In fungus, the genes producing Hsp70 protein are extremely 

conserved. Hsp70 is a chaperone-dependent as well as independent protein that is required for 

fungal growth and development. Hsp70 protein functional differentiation is influenced by the 

presence of Hsp70 in various cellular regions. In addition, fungal hsp70 was shown to be expressed 

in humans after diverse infections, suggesting that it may be used as a biomarker for illness[46]. 

Heat shock proteins (Hsp90 and Hsp70) have recently been identified as potential antifungal 

targets. They are highly expressed in stressful settings, such as antifungal medication treatments, 

and have a part in normal biological processes in fungi. Hsp90 and Hsp70 inhibitors have also been 

found to increase the potency of the drug AmB in A. terreus. As a result, a slew of heat shock 

proteins (Hsp90, Hsp60, and Hsp70) seems to be essential during A. terreus infections. Toxicity has 

long been a major worry, and medication targets are a new area of research. In the current context, 

research is focusing on the creation of numerous therapeutic targets to combat numerous fungal-

related diseases in both plants and animals. Due to its vast function in fungal survival under stress 

situations, Hsps is one such important subject to research on. Hsp90 has been presented as an 

antifungal target in recent years. Against A. fumigatus and Candida albicans, the Hsp90 inhibitors 

geldanamycin and its derivatives showed antifungal activity and a synergistic effect with 

caspofungin. Our research shed light on the biology of A. terreus, particularly the lead molecule 

shikonin. Docking has been done to see if typical medications like Amphotericin B, Shikonin as a 

phytochemical, and other significant inhibitors have the best inhibitory effect on Aspergillus terreus 

Hsp70 and Hsp90 proteins [47]. 

 



 

Figure 1: In-vitro combinatorial effect of Shikonin and Amphotericin B in Aspergillus 

terreus 

 

2.2  METHODOLOGY 

1.  LIGAND PREPARATION of  Molecule name: Shikonin and precursors named 

Geldanamycin and Cantharidin using UCSF Chimera tool.  

2.  PROTEIN PREPARATION of Targets in Aspergillus terreus: Hsp70 (Q0D231) and 

Hsp90 (Q0CE88) using  UCSF Chimera.  

3.  Retrieval of structures of Standard drug: Amphotericin B from DrugBank.  

4.  Based on studies done till now, precursors (standard inhibitors of Hsp70 and Hsp90) like 

Geldanamycin and Cantharidin were selected. 

5.   Molecular Docking was performed between HSP70 AND HSP90 proteins and Shikonin 

along with the reference precursors[48]. 

6.  Study of  In silico Pharmacokinetic properties of Shikonin, standard Drug and other 

precursor inhibitors with Hsp70 and Hsp90 targets of Aspergillus terreus.  

 

 

 

 



 

 

 

2.3  RESULTS 

 

Ligands  Hsp70 Protein  

(87.85% identity)  

Shikonin  -3.47  

Amphotericin B  -3.10  

Cantharidin  -4.61  

 

Ligands  Hsp90 Protein  

(81.29% identity)  

Shikonin  -6.70  

Amphotericin B  -11.10  

Geldanamycin  -8.74  



 

2.4 CONCLUSION 

 

Docking Analysis showed Significant Inhibition of Shikonin as a Phytochemicals and its 

inhibitory precursors along with comparable results of amphotericin B  with  Hsp70 and 

Hsp90 targets of Aspergillus terreus. 
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